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1 Overview
Introduction

Testing a 1000Base-T1 PHY's transmitter is accomplished through the use of 
various test modes defined in the 1000Base-T1 specification. See “Reference 
Documents” on page 44.

Keysight’s E6960A 1000Base-T1 TX Compliance Application Software (provided 
as a software option to the E6961A Automotive Ethernet Solution) provides five 
test modes for the testing and validating the transmitter waveform, transmitter 
distortion, transmitted jitter, and transmitter droop. The test modes change only 
the data symbols provided to the transmitter circuitry and do not alter the 
electrical and jitter characteristics of the transmitter and receiver from those of 
normal operation. 

Using the Keysight E6960A 1000Base-T1 Compliance application software along 
with an N5395C Ethernet Test Fixture greatly simplifies compliance testing. The 
software automatically configures all of the required test equipment reducing the 
overall test time.

The E6960A Software:

– Lets you select individual or multiple test to run.

Table 1-1 Test Modes

Test Mode Description

1 Setting Master and Slave PHYs for Transmit Clock Jitter in Linked Mode

2 Transmit MDI jitter test in MASTER mode

3 Not Used

4 Transmitter distortion test

5 Normal Operation in Idle Mode. Power Spectral Density (PSD) mask and power level test.

6 Transmitter Droop Test

NOTE
This E6960A User Guide is written as a guide to using the E6960A 1000Base-T1 
TX Compliance Application software.
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Overview 1
– Lets you identify the device being tested and its configuration.

– Shows you how to make oscilloscope connections to the device under test.

– Automatically checks for proper oscilloscope configuration.

– Automatically sets up the oscilloscope for each test.

– Allows you to determine the number of trials for averaging in each test.

– Provides detailed information of each test that has been run. The result of 
maximum 64 worst trials can be displayed at any one time.

– Creates a printable HTML report of the tests that have been run. This report 
includes pass/fail limits, margin analysis, and screen captures.
Keysight E6960A User Guide and Method of Implementation 11



1 Overview
Installing the Compliance Test Solution Software

1 Make sure you have the minimum version of Infiniium oscilloscope software 
(see the software release notes) by choosing Help > About Infiniium... from the 
main menu.

2 To obtain the E6960A Compliance Application software, go to Keysight 
website: http://www.keysight.com/find/E6960A.

3 Click the Trials & Licenses tab.

4 Click the Details & Download button.

5 Read and verify the Prerequisites and installation information. Follow the 
instructions to download and install the application software. Click the red 
Download button.

Installing the License Key

1 Request a license code from Keysight by following the instructions on the 
Entitlement Certificate. You will need the oscilloscope's “Option ID Number”, 
which you can find in the Help > About Infiniium... dialog box.

2 After you receive your license code from Keysight, choose Utilities > License 
Manager > Legacy Licenses.... Depending on the license acquired, select 
either Local License or Server License.

3 In the Install Option License dialog box, enter your license code and click 
Install License. Additional information is required for server based licensing. 
Please refer to your entitlement.

4 Click OK in the dialog box that tells you to restart the Infiniium oscilloscope 
application software to complete the license installation.

5 Click Close to close the Install Option License dialog box.

6 Choose File > Exit.

7 Restart the Infiniium oscilloscope application software to complete the license 
installation.

You can also install the license using Keysight License Manager. For detailed 
instructions, refer to the online help for the Keysight License Manager.
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Overview 1
Preparing to Take Measurements

Before running the E6960A automated compliance tests, you should calibrate the 
oscilloscope and probe. After calibrating the oscilloscope and probe, you are 
ready to start the Compliance Test Application and perform the measurements.

Calibrate the Oscilloscope

For information on performing the internal diagnostic and calibration cycle for 
your Keysight Infiniium oscilloscope, refer to the "User Calibration" topic in your 
oscilloscope's online help.

Probe Calibration

Before performing the automated tests, you should calibrate the probes. 
Calibration of the solder-in probe heads consists of a vertical calibration and a 
skew calibration. The vertical calibration should be performed before the skew 
calibration. Both calibrations should be performed for best probe measurement 
performance.

For information on performing probe vertical and skew calibration in your Keysight 
Infiniium oscilloscope, refer to the "DC Attenuation/Offset Calibration" and "Skew 
Calibration" topics in your oscilloscope's online help.

For more information on calibration/deskew procedures for your particular probe, 
refer to the probe's user's guide in the Keysight Probe Resource Center.

NOTE
If the ambient temperature changes more than 5 °C from the calibration 
temperature, internal calibration should be performed again. The delta between 
the calibration temperature and the present operating temperature is shown in 
the Utilities > Calibration menu.

NOTE
If you switch cables between channels or other oscilloscopes, it is necessary to 
perform cable and probe calibration again. Keysight recommends that, once 
calibration is performed, you label the cables with the channel on which they 
were calibrated.
Keysight E6960A User Guide and Method of Implementation 13



1 Overview
General Test Setup

Test Modes 1, 2, 5, and 6 require only the Infiniium oscilloscope and the device to 
be tested (Device Under Test or DUT). The test setup is described below. 
Differential Signal supplied to the Oscilloscope can be achieved either by using 
Two Oscilloscope Channels or a Single Differential Probe. The type of 
connection accepted can be selected in the Setup tab of the test application.

Two Oscilloscope Channels refers to connecting the differential automotive pair 
to the oscilloscope using only SMA cables. Refer to Figure 1-1 for more details.

Single Differential Probe refers to connecting the differential automotive pair to 
the Oscilloscope using a single differential probe. Refer to Figure 1-2 for more 
details. The only variation would be the Power Level Test that requires a balun.

Any variation from the above definition of differential signaling type is not 
recommended.

Test Mode 4 requires the N5395C Ethernet Test Fixture and an Arbitrary 
Waveform Generator (AWG). Refer to “Test Mode 4. Transmitter Distortion and 
MDI Return Loss” on page 29 for specific setup details. 

Test Mode 4 also includes an MDI S-Parameter Test. 

Test Mode 5 can also use the N9010B Signal Analyzer. Refer to “Test Mode 5. 
Transmitter Power Spectral Density, Transmitter Power Level and Transmitter 
Peak Differential Output Tests” on page 36 for specific setup details.

NOTE
For all tests, use the software supplied with your transmitter PHY to control the 
Device Under Test.
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Overview 1
Two Oscilloscope Channels Connection to Oscilloscope

Two SMA cables are needed to directly connect the output of the transmitter to 
the oscilloscope. The specific oscilloscope channel used can be selected in the 
Configure tab of the application.

An optional TX_TCLK may be supplied to the oscilloscope to run the tests.

Figure 1-1 Connection to the Oscilloscope Using a Pair of SMA Cables

Transmitter 
under test

TX+

TX-

100Ω

SMA Cables

Transmitter Clock to oscilloscope Ref Clock In
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1 Overview
Single Differential Probe Connection to Oscilloscope

A differential probe is used to connect the output of the transmitter to the 
oscilloscope. The specific oscilloscope channel used can be selected in the 
Configure tab of the application.

An optional TX_TCLK may be supplied to the oscilloscope to run the tests.

Figure 1-2 Connection to the Oscilloscope using a Differential Probe

Transmitter 
under test

TX+

TX-

100Ω

High 
Impedance 
Differential 
Probe

Transmitter Clock to oscilloscope Ref Clock In
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Overview 1
Connection Using the N5395C Ethernet Transmitter Test Fixture

Alternately, you can use Section 1 of the N5395C Ethernet 10/100/1G Transmitter 
Electrical Test Fixture to make connections to the Transmitter under test. The 
SMA connections shown are for wire pair A (DA+ and DA–). This connection is only 
valid if the DUT has an RJ45 connector. To test to wire pair B, C, or D, connect the 
oscilloscope SMA cables to the appropriate Evaluation Board SMA connectors. 
See Figure 1-3 below. In the event the DUT does not have an RJ45 connector, 
user will need to replace Section 1 with any adapter that converts the differential 
automotive pair to SMA.

Figure 1-3 General Test Setup using the N5395C Evaluation Board

BNC to 
SMA 
Cables

D+ D-

Transmitter 
Under Test 

(DUT)

RJ45 CAT5e LAN Cable N5395C Ethernet Transmitter Test Fixture
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1 Overview
Starting the Automotive Ethernet Compliance Test Solution 
Software

1 Ensure that the 1000Base-T1 Device Under Test (DUT) transmitter is operating 
and set to desired test modes.

2 To start the Compliance Test Application from the Infiniium oscilloscope's main 
menu, select Analyze > Automated Test Apps > E6960A 1000Base-T1 Test 
App. 

Figure 1-4 Launching the E6960A Compliance Test Application
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Overview 1
Figure 1-5 E6960A 1000Base-T1 Compliance Test Application Main 
Window

3 Figure 1-5 above shows the E6960A 1000Base-T1 Compliance Test 
Application main window.

4 The Compliance Application software automatically sets frequency, etc. of the 
external instruments (oscilloscope, ENA, generators, etc.) if they are properly 
configured. Refer to Appendix B, “Configure External Instruments” on page 51.

1

2

3

4

Item Description

1
Use TX_CLK. Check this if your DUT has its own Transmit Clock. Otherwise, the default clock signal is 
used.

2
Requires Frequency Divider Board. Refer Appendix D “Using the E6960-66600 Frequency Divider 
Board” on page 63

3 Refer to Appendix C “External Instrument Calibration” on page 55

4 Refer to Appendix B “Configure External Instruments” on page 51
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1 Overview
5 The task flow pane, and the tabs in the main pane, show the steps you take in 
running the automated tests.

Figure 1-6 Select Tests Menu with all tests selected

6 Figure 1-6 above shows all the tests that are available in E6960A 1000Base-T1 
Compliance Test Application.

Displays test limits, test description, and IEEE 
specification reference for the selected test.
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Overview 1
7 Table 1-2 above shows the function description of each tab in the Tabs Menu.

Table 1-2 Tabs Menu functions

Tab Description

Set Up Lets you identify and set up the test environment.

Select Tests
Lets you select the tests you want to run. After tests are run, status indicators show which tests have 
passed, failed, or have not run.

Configure
Lets you configure test parameters (for example, oscilloscope channels used in test, number of 
averages, etc.).

Connect Shows you how to connect the oscilloscope to the device under test.

Run Tests
Starts the automated tests. If the connections to the device under test need to be changed, the test 
pauses, shows how change the connection, and waits for you to confirm that the changes were made 
before continuing.

Automation Lets you construct scripts of commands to drive execution of the application.

Results
Contains more detailed information about the tests that have been run. You can change the thresholds 
at which marginal or critical warnings appear.

HTML Report Report Shows a compliance test report that can be printed. See “Viewing the Test Report” on page 42
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1 Overview
 

Figure 1-7 Configure Tab for Test Mode 1

8 Figure 1-7 above shows the figure tab that allows you to select different 
oscilloscope channels and measurement attributes.

The Configure Tab allows 
you to select different 
oscilloscope channels 
and measurement 
attributes.

For example, the signal 
input can be changed 
from a differential probe 
to two SMA cables.
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Overview 1
Figure 1-8 Connect Tab for Test Mode 1

9 Figure 1-8 above shows the connect tab of the E6960A 1000Base-T1 
Compliance Test Application.

Test connections are clearly identified including additional 
hardware and cables. When you make multiple tests where 
the connections must be changed, the software prompts you 
with appropriate connection diagrams.

Check the, “I have completed these instructions” box before 
clicking the Run Tests button.
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1 Overview
Top Menu Bar

The top menu bar of the compliance application offers several features:

Top Menu Bar icons from left to right:

Start a new project: Closes existing project and opens a new project.

Open an existing project: If you saved a previous project, this icon allows you 
to open it. You can load a sample project from: 
C:\Users\Public\Documents\Infiniium\Apps\1000BT1\ProjectSamples\1000Ba
seT1 Device1.proj.

Save the current project: Saves the current project in the following folder: 
C:\Users\Public\Documents\Infiniium\Apps\1000BT1\1000BaseT1 Device 
1.proj.

Configure checked tests: Same as the Configure tab.

Run all checked tests: Runs all of the selected tests. Same as the Run Tests 
tab.

Run selected branch only: Runs only the selected test.

View results: Opens the HTML Report window. Same as the Html Report tab.

Tabs

The tabs across the top correspond to the Task Flow icons on the left side of the 
main display.

Top Menu Bar

Tabs
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Overview 1
Test Mode 1. TX_TCLK125 Frequency and Transmit Jitter Tests

Test Setup

This test may be run using either two oscilloscope channels or a single differential 
probe from the transmitter (MDI). Refer to “General Test Setup” on page 14 for 
connection details.

Specification References

[1] 1000Base-T1 IEEE Std 802.3bp-2016, Section 97.5.3.6.

[2] 1000Base-T1 IEEE Std 802.3bp-2016, Section 97.5.2.

[3] 1000Base-T1 IEEE Std 802.3bp-2016, Section 97.5.3.3

TX_TCLK125 Frequency Test

This test measures the frequency of the TX_TCLK125 clock.

Reference [1] specifies the symbol transmission rate of a compliant PHY. The 
symbol transmission rate of the MASTER PHY shall be within the range of 750 MHz 
±100 ppm.

Reference [2] specifies that Test Mode 1 shall provide access to a frequency 
reduced version of the transmit symbol clock or TX_TCLK125. This 125 MHz test 
clock is one sixth frequency divided version of the TX_TCLK that times the 
transmitted symbols.

The measured frequency of TX_TCLK125 should fall within 125 MHz ±100 ppm.

NOTE
Use the software supplied with your transmitter PHY to control the Device Under 
Test.
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1 Overview
Transmit Clock Jitter (MASTER/SLAVE)

Test Mode 1 enables testing of timing jitter on MASTER and SLAVE transmitters. 
MASTER and SLAVE transmitters are connected over a link segment. The 
transmitter timing jitter is measured by capturing the TX_TCLK125 waveforms in 
both MASTER and SLAVE configurations. 

Reference [3] specifies that when in test mode 1, and the link is up and the two 
PHYs have established link, the RMS (Root Mean Square) value of the MASTER 
TX_TCLK125 jitter relative to an unjittered reference shall be less than 5 ps. The 
peak-to-peak value of the MASTER TX_TCLK125 jitter relative to an unjittered 
reference shall be less than 50 ps.

Reference [3] specifies that when in test mode 1, and the link is up and the two 
PHYs have established link, the RMS (Root Mean Square) value of the SLAVE 
TX_TCLK125 jitter relative to an unjittered reference shall be less than 10 ps. The 
peak-to-peak value of the SLAVE TX_TCLK125 jitter relative to an unjittered 
reference shall be less than 100 ps.

This test measures the clock time interval error of the TX_TCLK125 signal at the 
MDI. The ideal reference clock is selected automatically by the oscilloscope and 
compared to the original signal to determine the clock time interval error.
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Test Mode 2. Transmit Clock Frequency (MASTER) and MDI Output 
Jitter (MASTER) Tests

Test Setup

This test may be run using either two oscilloscope channels or a single differential 
probe from the transmitter (MDI). Refer to “General Test Setup” on page 14 for 
connection details.

Specification References

[1] 1000Base-T1 IEEE Std 802.3bp-2016, Section 97.5.3.6. 

[2] 1000Base-T1 IEEE Std 802.3bp-2016, Section 97.5.2.

[3] 1000Base-T1 IEEE Std 802.3bp-2016, Section 97.5.3.3.

Transmit Clock Frequency

Reference [1] specifies the symbol transmission rate of a compliant PHY. The 
symbol transmission rate of the MASTER PHY shall be within the range of 750 MHz 
±100 ppm.

Reference [2] specifies that in Test Mode 2 the PHY shall transmit a continuous 
pattern of three {+1} symbols followed by three {-1} symbols, with the transmitted 
symbols timed from its local clock source of 750 MHz. The transmitter output is a 
125 MHz signal. Hence the accuracy of the transmit clock frequency is also 125 
MHz ±100 ppm. 

MDI Output Jitter (MASTER)

Reference [3] specifies that when in test mode 2, the RMS (Root Mean Square) 
value of the MDI output jitter, relative to an unjittered reference shall be less than 5 
ps.

NOTE
Use the software supplied with your transmitter PHY to control the Device Under 
Test.
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1 Overview
Reference [3] specifies that when in test mode 2, the peak-to-peak value of the 
MDI output jitter, relative to an unjittered reference shall be less than 50 ps.

This test measures the data time interval error of the test mode 2 signal at the MDI. 
The ideal reference data rate is selected automatically by the oscilloscope and 
compared to the original signal to determine the data time interval error.
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Overview 1
Test Mode 4. Transmitter Distortion and MDI Return Loss

Test Setup

Sections 1 and 11 of the N5395C Ethernet Test Fixture are used in this test.

A disturbing signal source is required to test for compliance. There is an option to 
test without a disturbing signal source, but the test result is not applicable for 
compliance. The test accepts only a differential signal.

When using a supported function generator, there is an automatic calibration 
process to calibrate the function generators. If an unsupported model is used, the 
user will have to manually calibrate the function generators.

Only the Keysight 81150A Function Generator is supported in this test.

Figure 1-9 Connection for Transmitter Distortion Test Using Keysight 
81150A Function Generator

BNC to BNC Cables

LAN to USB cable

N5395A Ethernet Transmitter Test Fixture

DUT
SMA to 
SMA 
Cables

RJ45 CAT5e LAN 

BNC to 
SMA 
Cables

D+ D-
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1 Overview
Using the Optional E6960A Frequency Divider Board

If you want to use the optional E6960-66600 Frequency Divider Board to provide a 
stable 10 MHz reference clock, refer to Appendix D “Using the E6960-66600 
Frequency Divider Board” on page 63 for detailed information.

Specification References

[1] 1000Base-T1 IEEE Std 802.3bp-2016, Section 97.5.3.2.

[2] 1000Base-T1 IEEE Std 802.3bp-2016, Section 97.7.2.1.

Transmitter Distortion Tests Information

When operating in Test Mode 4 and capturing the waveform using the Section 11 
of the fixture, the peak distortion shall be less than 15 mV.

Reference [1] specifies that the peak distortion is determined by sampling the 
differential signal output with the symbol rate clock at an arbitrary phase and 
processing a block of any 2047 consecutive samples with MATLAB code in 
Reference [1].

Alternatively, this test can also be run without the disturbing signal, but the result 
cannot be used to determine compliance.

NOTE
If using the Frequency Divider, connect the 10 MHz output(s) of the divider to 
the 10 MHz Ref In Input of the oscilloscope and function generator for clock 
synchronization.
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Transmitter Distortion Enhance Clock Recovery Algorithm

Keysight employs an enhanced clock recovery algorithm when the TX_TCLK is not 
available. The algorithm conditions the signal to the nominal bitrate. This is 
enabled by default when the Use 10MHz Ref Clock checkbox is disabled.

When the Use 10MHz Ref Clock checkbox is enabled, the E6960-66600 
Frequency Divider board as well as access to TX_TCLK to is required for 
synchronization.

NOTE
This test can only be run using a differential output from the transmitter (MDI). 
Refer to “General Test Setup” on page 14 for connection details. A differential 
probe cannot be used for this test.
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1 Overview
MDI Return Loss Test

This test is run with an external vector network analyzer. However, a VNA 
exported data file in the Touchstone or CITI format can also be used in place of 
the external vector network analyzer. The external vector network analyzer will 
need to be manually calibrated prior to use. 

User has the option to either run a differential measurement, by selecting Two 
Oscilloscope Channels on the Setup tab or a single ended measurement(using 
BALUN) by selecting the Single Differential Probe signaling type. Please refer to 
“Calibrating the ENA” on page 59.
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Test Setup

Single Ended Connection Setup

Figure 1-10 Single Ended Connection Setup for MDI Return Loss Test
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1 Overview
Differential Connection Setup

Figure 1-11 Differential Connection Setup for MDI Return Loss Test
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MDI Return Loss Test Information

Reference [2] specifies that the differential impedance at the MDI for each 
transmit/receive channel shall be such that any reflection (due to differential 
signals incident upon the MDI with a test port having a differential impedance of 
100 Ω) is attenuated relative to the incident signal as per the equation below.

where f is the frequency in MHz.

In other words, the return loss shall meet or exceed the equation above for all 
frequencies ranging from 2 MHz to 600 MHz (with 100 Ω differential impedance) at 
all times when the PHY is transmitting data or control symbols.

ReturnLoss f( )

18 18 10log( )20
f

------– 2 f 20<≤

18 20 f 100<≤

18 16.7 10log( ) f
100
---------– 100 f 600≤ ≤

≥
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1 Overview
Test Mode 5. Transmitter Power Spectral Density, Transmitter 
Power Level and Transmitter Peak Differential Output Tests

Test Setup

The Power Spectral Density (PSD) Test can be run using either a spectrum 
analyzer or an oscilloscope. When using the oscilloscope, refer to “General Test 
Setup” on page 14.

If you use the N9010B Signal Analyzer, convert the differential output to a 
single-ended output using a balun. Use the balun on the N5395C Ethernet Test 
Fixture as shown in Figure 1-12 below.

The Power Level Test can be run using either the spectrum analyzer or and 
oscilloscope. For this particular test, irrespective of equipment used, convert the 
differential output to a single-ended output using a balun. Use the balun on the 
N5395C Ethernet Test Fixture as shown in Figure 1-12 below.

Figure 1-12 Power Spectral Density Test Using N9010B Signal Analyzer
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Specification References

[1] 1000Base-T1 IEEE Std 802.3bp-2016, Section 97.5.3.4.

[2] 1000Base-T1 IEEE Std 802.3bp-2016, Section 97.5.3.5.

NOTE
Use the software supplied with your transmitter PHY to control the Device Under 
Test.
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1 Overview
Transmitter Power Spectral Density (PSD)

Reference [1] specifies that in Test Mode 5, the power spectral density (PSD) of 
the transmitter, shall be between the upper and lower masks specified by the 
equations below. 

where f is the frequency in MHz.

The resolution bandwidth of 100 kHz and sweep time of larger than 1 second are 
considered in PSD measurements.

This test could be run using an external spectrum analyzer or the oscilloscope.

UpperPSD f( )

80– dBm
Hz

------------ 0 f 100≤<

76– f
25
------– dBm

Hz
------------ 100 f 400≤<

85.6– f
62.5
----------– dBm

Hz
------------ 400 f< 600≤

=

LowerPSD f( )
86– dBm

Hz
------------ 40 f< 100≤

82– f
25
------– dBm

Hz
------------ 100 f< 400≤

=
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Transmitter Power Level

Reference [1] specifies that in Test Mode 5, the transmit power shall be less than 5 
dBm.

Transmitter Peak Differential Output

Reference [2] specifies that in Test Mode 5, when measured with 100 Ω 
termination, the transmit differential signal at MDI shall be less than 1.30 Volt 
peak-to-peak.
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1 Overview
Test Mode 6. Output Droop Tests

Test Setup

This test may be run using either two oscilloscope channels or a single differential 
probe from the transmitter (MDI). Refer to “General Test Setup” on page 14 for 
connection details.

Specification References

[1] 1000Base-T1 IEEE Std 802.3bp-2016, Section 97.5.3.1.

Transmitter Output Droop Positive Test Information

This test measures the positive output droop of the transmitter.

Reference [1] specifies the positive output droop of a compliant PHY. The positive 
droop measured with respect to an initial value at 4 ns after the zero crossing and 
a final value of 16 ns after the zero crossing, shall be less than 10%.

The application triggers the Test Mode 6 signal on the rising edge and determines 
the time the positive peak occurred at 4 ns after the zero crossing. The application 
then measures the voltage 12 ns after the initial peak crossing. The Droop is 
calculated as:

Droop = 100 X (Vd/Vpk)%

Where:

– Vd is the magnitude of the droop.

– Vpk is the initial peak after the zero crossing.

NOTE
Use the software supplied with your transmitter PHY to control the Device Under 
Test.
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Transmitter Output Droop Negative Test Information

This test measures the negative output droop of the transmitter.

Reference [1] specifies the negative output droop of a compliant PHY. The negative 
droop measured with respect to an initial value at 4 ns after the zero crossing and a 
final value of 16 ns after the zero crossing, shall be less than 10%.

The application triggers the Test Mode 6 signal on the falling edge and determines 
the time the negative peak occurred at 4 ns after the zero crossing. The application 
then measures the voltage 12 ns after the initial peak crossing. The Droop is 
calculated as:

Droop = 100 X (Vd/Vpk)%

Where:

– Vd is the magnitude of the droop.

– Vpk is the initial peak after the zero crossing.
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1 Overview
Viewing the Test Report

After running any or all of the five Compliance tests, the Results tab shows which 
tests passed and details about the individual tests. For test result details, select 
any one of the tests from the top pane; the test details are shown below. In 
Figure 1-13 below, the jitter test is selected and the test results, with waveform, is 
shown below. 

Figure 1-13 Typical Results Tab

Figure 1-14 below shows a portion of a typical HTML Report. Below this segment 
are waveforms and more test data.
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Figure 1-14 Top Portion of a Typical HTML Report
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1 Overview
Reference Documents

IEEE 802.3 Ethernet Working Group:

www.ieee802.org/3/index.html

Keysight’s Automotive Ethernet Test Solutions Web Page: 

www.keysight.com/find/broadr-reach

E6960A Automotive Ethernet TX Compliance Solution Web Page:

www.keysight.com/find/E6960A

Other Keysight Automotive Ethernet Applications and Software

– E6960A 1000Base-T1 TX Compliance Application: 
www.keysight.com/find/E6960A

– E6961A Automotive Ethernet TX Compliance Solution: 
www.keysight.com/find/E6961A

– E6962A Automotive Ethernet RX Compliance Solution –
includes E6962A RX Compliance Application (100Base-T1 compliant) 
software:
www.keysight.com/find/E6962A

– E6963A Automotive Ethernet Link Segment Compliance Solution – includes 
E6963A Link Segment Compliance Application (100Base-T1 compliant) 
software:
www.keysight.com/find/E6963A

– N6467B Transmit Compliance Application Software (100Base-T1 compliant):
www.keysight.com/find/N6467B

– N8847A Protocol Triggering and Decoder Software (100Base-T1 compliant)
www.keysight.com/find/N8847A

THIS PAGE HAS BEEN INTENTIONALLY LEFT BLANK.
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A Setting Up the N5395C Ethernet Transmitter Test Fixture
Introduction

Keysight’s N5395C Ethernet 10/100/1G Transmitter Electrical Test Fixture 
includes a main test fixture board (N5392-66402), a short RJ-45 interconnect 
cable (N5392-61601), and a small Return Loss impedance calibration board 
(N5392-66401).

Keysight’s N5395C Ethernet Test Fixture is recommended for the Compliance Test 
Mode 4. A different, comparable fixture may be used, but is not guaranteed to 
produce the same result.

Notice that the main Test Fixture board is divided into eight sections plus an area 
to store jumpers. Not all sections are used in this demo/evaluation. Refer to 
Figure A-1 on page 47.

The Return Loss impedance calibration board is Board Section 8. See Figure A-2 
below. This board is used for calibrating the ENA. Refer to “Calibrating the ENA” 
on page 59. This board is only applicable if your DUT has an RJ45 connector. For 
other DUT's that do not have a RJ45 connector, user will need to fabricate a 
custom calibration kit.

Table A-1 List of Compliance Test Board Sections

Compliance Test Board 
Section

Description Compliance Test Mode Number

1 Differential Return Loss used for RJ45 devices Test Mode 4, Transmitter Distortion Test

2 Load & Probes Not Used

3 100BT Jitter Not Used

4 Common Mode Output Voltage Not Used

6 10BT w/o TP Model Not Used

7 10BT with TP Model Not Used

10 Balun used for Power Spectrum Density Test Test Mode 5, PSD and Power Level Test

11 Disturbance/Distortion Test Mode 4, Transmitter Distortion Test
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Setting Up the N5395C Ethernet Transmitter Test Fixture A
Figure A-1 N5395C Ethernet Electrical Transmitter Test Fixture

Figure A-2 Return Loss Impedance Calibration Board
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A Setting Up the N5395C Ethernet Transmitter Test Fixture
Jumper Settings

Figure A-4 shows the jumper position for the Ethernet Test Fixture Section 11 
applicable for E6960A Compliance Test.

Figure A-3 Section 11 on the Ethernet Test Fixture. 

Section 11 
Jumpers. See 
Figure A-4 for 
settings.
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Setting Up the N5395C Ethernet Transmitter Test Fixture A
Figure A-4 Jumper Location for Ethernet Test Fixture

NOTE
If you need similar jumper cables, please contact your Keysight sales 
representative for more details.
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A Setting Up the N5395C Ethernet Transmitter Test Fixture
THIS PAGE HAS BEEN INTENTIONALLY LEFT BLANK.
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B Configure External Instruments
Introduction

For each test, the DSOS254A Infiniium Oscilloscope automatically configures any 
external instruments (AWG, E5071C ENA, and N9010B EXA Signal Analyzer) as 
required for the test. In order to do this, however, the oscilloscope must know the 
SICL address of each instrument. The External Instruments Status indicator is red 
if the instruments are not properly configured.

1 From the Compliance Test Application Set Up tab, click the Configure button. 
This opens the External Instruments List dialog box.

Figure B-1 E6960A Compliance Test Application Main Menu

NOTE
The instruments must be connected to the oscilloscope prior to configuring 
them. This is generally through a USB connection.
52 Keysight E6960A User Guide and Method of Implementation



Configure External Instruments B
Figure B-2 BroadR-Reach Compliance Test Application External 
Instruments List

2 Select the AWG used in your system. For the E6961A Solution, this would be 
the Fg81150/60.

3 If you know the SICL address (you can use Keysight IO Libraries Suite 
Connection Expert utility to obtain the SICL address) enter it in the SICL 
Address field. If you do not know the SICL address, click the Find button and 
the Test Compliance Software will attempt to locate and identify the AWG.

4 Click the Update button.
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B Configure External Instruments
5 Repeat steps 3, 4, and 5 for the E5071C ENA and the N9010B EXA Spectrum 
(or Signal) Analyzer. 

6 When you are finished, click the Done button to return to the Main Menu.

7 The External Instruments Status indicator turns green to indicate that all 
external instruments have been properly configured.
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C External Instrument Calibration
Introduction 

All instruments must be calibrated prior to running the Compliance tests. The 
compliance application software guides you in calibrating the AWG and the ENA.

Calibrating the AWG

Before running disturbing signal tests, the AWG must be calibrated. Connect the 
equipment as shown in Figure 1-9 on page 29.

NOTE
The AWG Disturbing Signal Source must be Configured before attempting to 
Calibrate it. If the system is not physically configured to perform the calibration, 
the application prompts you to change the physical configuration. Refer to 
“Appendix B. “Configure External Instruments” on page 51

NOTE
Instead of connecting SMA to SMA cables on the N5393C Evaluation Board, 
connect 50 Ω Terminators to the two DUT SMA Connectors on the Evaluation 
Board. This is shown in Figure C-1 below
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External Instrument Calibration C
Figure C-1 AWG Calibration Setup for the Disturbing Signal Source

Performing the AWG Calibration for the Disturbing Signal Source

1 From the E6960A Compliance Test Application software main menu, click the 
Calibrate Sources button.

Connect BNC to BNC 
cables to AWG Connect 50Ω SMA 

Terminations

BNC to SMA Cables

N5395A Ethernet Transmitter Test Fixture
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C External Instrument Calibration
Figure C-2 E6960A Compliance Test Application Main Menu

2 This opens the Calibrate Disturbing Signal dialog box for the selected AWG. 

3 With the appropriate AWG Address set and the correct oscilloscope channels 
selected, click the Calibrate button to start the calibration process.

4 When the software finishes the calibration, click the Done button to return to 
the Main Menu. Refer to the E6960A online help for a more detailed 
explanation.
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External Instrument Calibration C
Calibrating the ENA

Using the Return Loss Calibration board

Before using the ENA, it must be calibrated using the Return Loss Calibration 
board. See Figure C-3 below for the connection diagram. Calibrate the ENA using 
the instructions in the ENA’s User’s Guide.

Figure C-3 ENA Calibration Setup (Return Loss)

Short 
SMA 
Cables

N5395A Ethernet Transmitter Test Fixture

Return Loss Impedance 
Calibration Board

Short RJ45 cable

Short OpenLoad
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C External Instrument Calibration
1 Connect the Return Loss Calibration board RJ45 connector labeled OPEN to 
the RJ45 connector on the main test fixture board using a short 
straight-through UTP cable.

2 Connect one end of two short SMA-to-SMA cables to the SMA test points for 
the pair you are testing (A, B, C, or D) on Section 1 of the test fixture. Connect 
the other end to the two SMA test points on Section 10 on the test fixture.

3 Connect a ENA input to the SMA test point on Section 10 on the test fixture.

4 Calibrate the ENA using the instructions in the ENA’s User’s Guide. The 
following is a list of setup requirements.

– Set Measurement to Ref1 Fwd S11.

– Set Start to 2 MHz.

– Set Stop to 600 MHz.

– Set Format to Log Mag.

– Set Scale Div to 5.

– Set Scale Ref to reference line position 9.

5 Run the calibration for the OPEN, SHORT, and LOAD connections.

NOTE
For connectors other than RJ45, a custom calibration kit will need to be 
developed.
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External Instrument Calibration C
Using ECal Module

Before using the ENA, it must be calibrated using the N4431B ECal Kit. See 
Figure C-4 below for the connection diagram. Calibrate the ENA using the 
instructions in the ENA’s user guide.

Figure C-4 ENA Calibration Setup (ECal Module)

1 Connect the USB port on the ECal module with the USB port on the E5071C 
via a USB cable. This connection may be done while the E5071C’s power is on.

2 Allow the Ecal module to warm up for 15 minutes until the module indicator 
changes from WAIT to READY.

3 Connect port A and port B on the Ecal module to the ENA’s test ports (using 
SMA cables) to be calibrated. Use the N-type (M) to SMA Adapter for easy 
connection of SMA cables.

4 Press Channel Next/Channel Prev keys to select the channel for which you want 
to perform the calibration.
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C External Instrument Calibration
5 Click ECal.

6 Click 2 Port ECal.

– When using a 2-port E5071C, pressing this key performs a 2-port ECal.

– When using a 3-port or 4-port E5071C, click one of the softkeys to start a 
full 2-port calibration.

7 The following is a list of setup requirements prior to running the calibration 
routine.

– Set Measurement to Sdd11.

– Set Start to 2 MHz.

– Set Stop to 600 MHz.

– Set Format to Log Mag.
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D Using the E6960-66600 Frequency Divider Board
Introduction

Keysight’s E6960-66600 Frequency Divider Board produces two identical clock 
signal outputs (10 MHz) that are phase locked to the input clock. This Frequency 
Divider Board is recommended for Compliance Test Mode 4, Transmitter 
Distortion Test.

Figure D-1 Keysight’s E6960-66600 Frequency Divider Board
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Static-safe Handling Procedures

Electrostatic discharge (ESD) can 
damage or destroy electronic 
components. Use a static-safe work 
station to perform at work on 
electronic assemblies. This figure 
shows a static-safe work station using 
two types of ESD protection:

– Conductive table-mat and 
wrist-strap combination

– Conductive floor-mat and 
heel-strap combination

Both types, when used together, 
provide a significant level of ESD 
protection. Of the two, only the table-mat and wrist-strap combination provides 
adequate ESD protection when used alone. To ensure user safety, the static-safe 
accessories must provide at least 1 MΩ of isolation from ground.

Observe appropriate ESD precautions before connecting and disconnecting 
cables and changing the positions of jumpers ans switches.
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To use the divider board, check the Use 10MHz Ref Clock on the E6960A Main 
Application Window

Figure D-2 Check the Use 10MHz Ref Clock on Main Application Window
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Configure the test setup as shown below.

Figure D-3 Test Setup for 10 MHz Frequency Reference

Frequency Divider Board Test Setup

1 Connect CH1 SMA connector to the Device Under Test (DUT).

2 Use BNC to BNC cables to connect both J400 and J403 BNC connectors to 
the oscilloscope and the AWG 10 MHz In.

3 Select 4.2 Vpp output voltage by shorting Pin1 and Pin2 of J100 with jumper.
Remark: 10MHz ref input amplitude and frequency specification for every 
oscilloscope might be different. Please ensure the oscilloscope that you use 
meets the specifications. In the event it doesn't, an attenuator might be 
required.

4 Select Normal Running mode by switching switch A1 to OFF.

5 Select Frequency Tracking mode by switching switch A2 to OFF.

LAN or USB cable

BNC to BNC Cables

N5395A Ethernet Transmitter Test FixtureRJ45 CAT5e LAN Cable

BNC to 
SMA 
Cables

D+ D-

10MHz Ref in to oscilloscope and AWG Master BNC to BNC cables

Frequency 
Divider 
Board

TX_CLK

SMA to SMA 
cable

DUT
SMA 
to 
SMA 
Cables
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6 Select CH1 as input by switching switch A6 to OFF.

7 Select Targeted 25 MHz input by switching switch B2 to ON.

8 Power on the board by connecting a power source to the USB connector or to 
the DC power jack. (4.5V to 5.5V @450mA).

At power on, the:

– Power LED PWR (D303) should light up as GREEN

– LED A (D302) should light up as GREEN

– LED B (D304) should light up as GREEN

Connector Description 

This section describes the various user components on the E6960-66600. 

USB type-B / DC Jack 

Provides power to the fixture. Either the USB port or the 2.5 mm, center positive 
purpose. Input voltage is required to be within +4.5V to +5.5V @500mA. Any 
voltage that is out of specification will trigger a warning on the Power LED. 

SMA 

Provides an interface to feed the input signal into the test fixture. CH1 connector 
is 50 Ω terminated and CH2 connector is 10k Ω terminated. 

BNC 

Both J400 and J403 produce a separate output clock signal. The signals are 
back-terminated by 50 Ω. 

Jumpers 

Provides user the option to modify the test fixture circuitry. 

J100 This jumper controls the output signal amplitude: 

4.2Vpp: Connect pin 1 and pin 2 

3.3Vpp: Connect pin 2 and pin 3 

3.0Vpp: Connect pin 3 and pin 4 
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J300 & J302 This jumper allows user to probe the channel 1 and channel 2 
inputs respectively 

J401 This jumper shorts both outputs together. 

J402 Parking location for unused jumpers. 

DIP Switch Description 

Switch A 

Switch A sets the Fixture operating mode.

Table D-1 Switch A function states

Switches Position Operating mode Comment 

A1 
off Normal running mode Normal operating mode 

on Sleep mode Change made to any of the switches are ignored 

A2 
off Frequency Tracking Mode Output frequency track to input frequency 

on Lock Frequency Mode Output clock is phase lock to input clock 

A3 
off NA NA 

on NA NA 

A4 
off NA NA 

on NA NA 

A5 
off NA NA 

on NA NA 

A6 
off Select CH1 as input NA 

on Select CH2 as input NA 

A7 
off NA NA 

on NA NA 

A8 
off NA NA 

on NA NA 
Keysight E6960A User Guide and Method of Implementation 69



D Using the E6960-66600 Frequency Divider Board
Switch B 

Switch B sets the frequency divider to the relevant setting.

Note: Other combinations are not valid. if no valid switch setting is detected, LED 
will flash indicating invalid switch B configuration. After reset, if no valid position 
is detected, the board uses the “Free Run Mode” which generates an accurate 10 
MHz signal. 

LED Description 

Power LED 

Table D-2 Switch B function states

Divider Comment 

B1 B2 B3 B4 B5 B6 B7 B8 To obtain 10 MHz output:

off off off off off off off off Not valid (def) Free Run Mode 

on off off off off off off off Div 1 Targeted 10MHz input clock 

off on off off off off off off Div 5/2 Targeted 25MHz input clock 

off off on off off off off off Div 20/3 Targeted 66.67MHz input clock 

off off off on off off off off Div 25/2 Targeted 125MHz input clock 

off off off off on off off off Div 75 Targeted 750MHz input clock 

Table D-3 LED indicators

Green Red 

Input voltage below 4.5V ON Flash 1 Hz 

Input voltage below3.6V ON Flash 2 Hz 

Input voltage above 5.5V ON ON 
70 Keysight E6960A User Guide and Method of Implementation



Using the E6960-66600 Frequency Divider Board D
LED A 

LED B 

Table D-4 LED A indicators

Green Red 

Input signal locked (Normal condition) ON OFF 

Lost of Lock Flash 1 Hz OFF 

Lost of Signal OFF Flash 1 Hz 

Lost of 48MHz reference OFF ON 

Table D-5 LED B indicators

Green Red 

Valid switch B configuration (Normal condition) ON OFF 

Invalid switch B configuration Flash 1 Hz OFF 

Missing input signal/ input signal out of range/ Warning. See LED A for list of 
warning 

N/A ON 
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THIS PAGE HAS BEEN INTENTIONALLY LEFT BLANK.
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